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one: unpacking the player

Upon unpacking your empeg car player, please check that
each of the following items are enclosed:
•
•
•
•
•
•
•
•
•
•

empeg car player
Car mounting cage
Infra red remote control
Home power supply
emplode software CD
USB connection cable
Serial connection cable
9 to 25 pin serial adaptor
This manual
Car bumper and window stickers

If any of the items are missing, please contact us at
support@empeg.com (see contact details in appendix f)
Other items you may require are:
• Ethernet cable with RJ-45 connector for 10BaseT
• Phono (RCA) lead to connect to home amplifier
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two: car installation

The empeg car unit is no harder to install than any other
car head unit, however, if you are not experienced with
head unit installation we recommend you leave the job to
a professional. As with other two-part (head unit and
separate amplifier) combination systems, the sound
quality – and in particular audio interference – is greatly
affected by the way the units are wired.
A good car audio specialist will be able to supply and
install a suitable amplifier as well as fitting the empeg car.

Amplifier requirements
The unit has high-level line outputs, and requires an
amplifier that can handle 3.2V RMS line outputs: ideally,
you need to test the empeg unit with the amplifier you
intend to use before purchasing it. Ensure you get an
amplifier with an adjustable gain control so that it can be
matched to the empeg car’s output levels.
The unit provides four channels (two left/right pairs, one
for front and one for rear), so for a four-speaker system
you will require either a four-channel amp or 2x twochannel amps. The empeg does not provide a separate
subwoofer out – an external active crossover is
recommended for this.
When setting up the amplifier the gain should be turned
to minimum (least sensitive) and then, with the empeg car
set to maximum output (0dB attenuation), turned up until
your maximum listening level is reached. Too high a
sensitivity setting will cause both distortion at high
volumes and interference at low levels.
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Mounting orientation
The unit is designed to mount close to horizontal: ideally,
the unit should be leaning back at an angle of 8 degrees
(this is fairly common practice in car dashboards) but
angles from 0 degrees to 16 degrees tilt (the rear of the
unit being lower than the front) are acceptable.
The unit is not designed to be mounted vertically (front
faces upwards) or on its side, as this compromises the
effectiveness of the shock mountings inside the unit.

Physical
The empeg car dock is a DIN-E sized unit: the aperture it
fits into is the standard size of 183mm (7.2") wide and
50mm (2") high. The unit is 173mm (6.8") deep, including
cables.
As with other DIN units, the unit is secured with push-out
tabs that hold onto the dashboard. After completing the
wiring of the dock, it should be pushed into place and the
appropriate tabs pushed out (so they protrude on the
outside of the dock) in order to hold the dock securely in
place.

Summary of electrical connections
Power
Black
Yellow
Orange
White
Blue
Green

Earth
Permanent power input
Ignition sense input
Headlights sense input
Amplifier remote power on
Mute input (e.g. for mobile phone)

The above connections are brought out to a standard ISO
car audio connector, suitable for direct connection to
many modern vehicles. For vehicles without an ISO
connector, the mating connector is available from all good
car audio suppliers.
Audio
Line out (front pair/rear pair)
Line in (pair)
Microphone in (3.5" jack)

4 volt output
1 volt input
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Digital
RS232 Serial port (9-way female D type)
empeg Tuner port (8-way male)

Electrical connection details
Ground (black)
The empeg car works with negative earth cars only. The
case is connected to ground, as is this connection.
Permanent power input (yellow)
The power input takes a maximum of 1A at 12V to power
the unit: any current taken by the amplifier remote line
will increase this value. The line is fused at 3A, and the
empeg unit is internally fused at 3A. If the fuse blows,
investigate and rectify the problem (check the empeg unit
powers up with the home power adapter) and always
replace with a fuse of the same type and rating.
An in-line power filter is fitted into the power line to filter
out ignition noise from the car supply.
The unit has a solid-state internal fuse. If this is tripped,
disconnect the unit from the power supply and leave for a
few minutes to allow the fuse to reset, and check the unit
works with the mains adapter before trying it again in the
car. If the solid state fuse trips, a faint “hot electrical”
smell may be detected – this is normal.
The power input should be connected to the permanent
12V power line of the car wiring. The empeg car can
function with a supply voltage from 8V to 16V DC. Audio
quality may be reduced at low voltages.
Ignition sense input (orange)
This 12V input should be connected to the vehicle
switched accessories line. To prevent excessive battery
drain, it should only be powered when the ignition is
switched on.
Headlights sense input (white)
This 12V input should be connected to the dashboard
night illumination line. It activates the automatic night
display dimmer feature.
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This line is used to turn the external amplifiers on. It
should NOT be used to power the amplifier, as it is a
low current line, which can supply a maximum of 1
amp at 12V – this should be connected to the
amplifier’s ‘Remote’ line, with the amplifier drawing
its power from a direct battery feed.
Amplifier remote power on (blue)
This line can also be used to control an automatic
antenna, with the same proviso on current sourcing as
above. Note that the antenna will extend whenever the
empeg is switched on, regardless of whether the tuner,
digital audio or auxiliary source is selected. Some empeg
tuner modules may have a dedicated antenna control
output which would be preferable for this application.
Mute input (green)
This 12V input is used to automatically mute or pause the
audio output. This is primarily intended for use with an incar cell phone.
Audio
There are two pairs of audio outputs on phono (RCA)
connectors, with an output level of approximately 3.2V
RMS. The 1V line inputs can take audio from other head
units or portable CD/DAT/Minidisc players and route it
through the empeg Aux channel.
The microphone input is suitable for connection to a
passive condenser mic or an active DSP mic.
Digital
The empeg car’s serial port docks with the car mounting
cage, allowing connection to permanently fitted in-car
computer equipment. The connector provides transmit,
receive, flow control, ground and +12V outputs on a 9
pin RS232 connector.
If this connector is not used, care must be taken to
ensure that it is insulated due to the 12V output
present on pin 4.
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three: windows software
installation

It is important to ensure that you do NOT connect
the empeg player to your PC via USB before
commencing the Windows software installation. If
you do so Windows will prompt you to supply a
driver location – do not do so, but rather cancel the
dialog box, disconnect your player, and continue
with the instructions that follow.
Insert the empeg car emplode disc into your CD drive. The
installation wizard will automatically start, unless you
have disabled auto-run in which case open the CD and
double click the Setup icon in the emplode folder.
The emplode License Agreement will be displayed. Please
read this and click Yes to indicate acceptance of the terms
if agreeable to you. Release notes will then be displayed,
which should be read before clicking Next.
You will be prompted to enter your name, company (if
applicable) and serial number. The serial number can be
located on the silver label attached to your player. Please
type the number exactly as it appears, including leading
zeros, then click Next.
If you wish to change the default installation folder you
can now do so by clicking Browse, otherwise click Next to
continue. You can now specify the Start Menu location for
the emplode icons, and click Next once more.
The software will now install onto your computer. Once
complete, click Finish.
At this stage, it is recommended that you restart your
computer.
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Uninstalling the Windows software
If you should wish to remove the empeg emplode
software from your computer, open the Add/Remove
Programs dialog from the Control Panel. Scroll down the
list of installed programs, select ‘empeg car Management
Software’ and click Add/Remove. The software will now
be totally removed from your computer.

Macintosh users using emulation software
emplode works with PC emulation products such as
Virtual PC, RealPC and SoftWindows; providing an
appropriate version of Windows is installed.
USB support depends upon the hardware and emulation
product. Please note that we are unable to provide
support for emplode running under emulation.
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four: home installation

To download and organise music on your player you will
need to connect it to a mains power outlet and PC. The
power adapter and cables that are required for this are
supplied with the player. You may also wish to connect
your player to your home stereo to listen to your digital
music out of the car – an additional cable is required for
this purpose.

Connecting to mains power
Connect the power adapter to the empeg car player
power socket on the rear panel. As soon as the power
adapter is plugged into a live socket the player will power
up ready for use.
Note that the supplied power adapter is auto-ranging,
suitable for use with voltages from 100V to 240V.

Connecting to your home computer
You can connect your empeg car player to your home
computer with USB, 10Base-T Ethernet or RS232 Serial.
USB or Ethernet are the recommended options for
downloading tracks, as they are much faster than Serial.
You will need to use the Serial connection if your
computer does not have (or support) USB or TCP/IP
Ethernet connections and when upgrading the software in
the player. USB is not available on Windows 95 (including
OSR2) or Windows NT 4.0.
The Serial cable requires a 9-pin port – the supplied
adapter is necessary for connection to a 25-pin port.
To connect your player, simply insert the appropriate cable
into the port on the rear panel of the player and into your
computer. You should avoid connecting the USB cable
until you have installed the supplied software (refer to
section three).
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If you wish to connect the empeg car to an existing
ethernet network, you will require an Ethernet Patch cable
with RJ-45 connectors (not supplied) to connect into a
hub. If you wish to connect the empeg car directly to a
computer, you will require an Ethernet crossover cable
(not supplied) with RJ-45 connectors.

Connecting to your home stereo
The phono (RCA) jacks on the rear of the player provide
1V line outputs suitable for direct connection to a home
amplifier. A cable for this purpose can be obtained from
any electronics or hi-fi outlet (be sure to check the
connections required by your amplifier).
Note that the line outputs cannot drive any load directly –
do NOT connect them to speakers or headphones.
For home use it is strongly recommended that you
set the output gain (volume) on the player to 0dB
and adjust the volume from your amplifier. This will
ensure optimum signal to noise ratio.
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five: the emplode music
management software

Before proceeding with this section, install the emplode
software as described in section three.

Introduction
The emplode program is responsible for managing the
music database on your empeg car player, including
loading tracks, setting and changing track details and
organising your music. The program runs on your home
computer and communicates with your player via a USB,
Ethernet or Serial connection – refer to section three for
details of making this connection.

Documentation
This guide gives a basic overview for using emplode.
Full documentation is provided with the program via the
Windows help system.

Encoding your music
Before music can be played by the empeg car it must be
encoded in a supported audio format. Currently
supported formats are MP3 and MP2, with more coming
in subsequent software upgrades. These formats compress
the data yet maintain excellent audio characteristics,
which is why the empeg car can store so much music.
The empeg emplode software does not perform the
encoding – this may have been performed by your music
vendor (if you are purchasing tracks in MP3 format) or, if
you wish to encode your own CD collection, a third party
product is required. There are many such products – some
free, some commercial – available from the Internet and
computer stores. We recommend Audio Catalyst by Xing
Technology (http://www.xingtech.com) as it is fast, of high
quality and easy to use.
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It is particularly convenient for your MP3 encoded tracks
to have ID3 tags. This feature of many encoding programs
incorporates track titles, artist names and other details
into the encoded track – often automatically via Internet
music databases. If these details are included at the time
of encoding it will save you time later.

Starting the emplode program
The empeg music database is stored on the car player
itself, never on your PC, so before you can use emplode
you must connect your player to the computer (refer to
section four) and switch it on.
Load the emplode program from the Start Menu (by
default it will have been placed in a sub menu called
‘empeg car’). If the player is connected and switched on a
short sequence will take place during which the music
database is retrieved.
If this does not happen check that the player is powered
up and connected correctly. It may be necessary to tell
emplode how the player is connected – click Options to
open the configuration window. If the player is connected
via USB select ‘Universal Serial Bus’. If it is connected by
RS232 Serial select ‘Serial port’ and choose the port
number from the drop down list. Refer to the emplode
help system for details of how to configure an Ethernet
connection. Click OK when you have selected the
appropriate connection: emplode will now attempt once
again to connect to the car player.
When the connection has been successfully made, and the
music database retrieved, the emplode main window will
open.
emplode connection
options window
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Playlist tree
Tracks on the empeg car player are organised into
playlists. A playlist is simply a collection of tracks that are
grouped together, perhaps because they have a common
theme; they may be from a certain album, by a certain
artist, or of a certain genre. A playlist can contain further
playlists (known as nested lists), and it is this hierarchy
that provides for fast selection of music on the player.
The top-level playlist, which is always present, is called
‘empeg car’ by default and cannot be deleted. A playlist
called ‘Unattached items’ is also listed. This contains items
not in a playlist. On the player, these items appear in the
first menu under playlists. From thereon the structure of
your music database is entirely up to you. The way in
which you choose to organise your music will reflect your
personal preferences.
In the example window shown on page 16, you can see
that tracks have been grouped into artist, group and
genre playlists. In fact, the tracks in each of the genre
playlists are copied from an artist or group playlist. You
can refer to a track in as many playlists as you want, but it
will only be stored once in the player so no capacity is
wasted.
When a playlist is selected on the car player, the tracks in
any nested lists will also play, and so on until the entire
branch of the tree has played. For example, the top level
empeg car playlist contains all of the tracks on the player,
whereas the artist playlist shown contains all of the tracks
for each of the artists.
You may choose to organise your music in an entirely
different way to this – it’s up to you!
It’s easy to navigate the playlist tree: open a branch by
clicking the + symbol, and close it again by clicking the –
symbol. Alternatively you can double click on a list to
open or close it’s branch. To select a playlist, simply
highlight it by clicking.
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Track list
The track list displays each of the tracks and nested lists
that are contained in the highlighted playlist. Four views
are available: Large Icons view, Small Icons view, List view
and Details view. The view can be changed from the View
menu, or from the toolbar controls.
In the List view (which is the recommended setting) click
the headings to change the sort criteria.
Tracks are represented by this icon:
Playlists are represented by this icon:
To change the play order of a track within the list, click
and drag it over the track that it is to precede. To delete a
track highlight it and press the Delete key, or select Delete
from the Edit menu. Tracks and playlists can also be Cut,
Copied and Pasted in the usual way, and a convenient
pop-up menu is provided by right clicking over a track or
playlist.

emplode displaying
playlists on left and
track list on right

As well as dragging tracks and playlists within the current
view, they can also be dragged onto other lists in the
Playlist Tree. If you drag and drop the item will be moved
to the appropriate list – if you hold down the Ctrl key
before dropping the item will be copied instead.
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Creating a new playlist
Select the playlist in which you wish to
create the new list, by clicking on it in the
Playlist Tree – if you are starting with a
blank player this will be the top level
‘empeg car’ playlist. From the Edit menu
select New Playlist, or click on the New
Playlist control on the toolbar.
The Properties window will open, in which you can specify
the title of the list. The other fields are entirely optional
and may be used in future versions of the player software
for track retrieval. Type in the title of the playlist and click
OK.
The new playlist will have been created, and can be
navigated as described above.

Adding a track to a playlist
Open the playlist to which you wish to add a track and
click anywhere in the Track List section of the window.
From the Edit menu select New Tune or click on the New
Tune control on the toolbar. The Open File window will
appear, from which you can navigate your computer in
the usual way. Locate and select the track that you wish
to add to your player and click Open.
The Properties window will open, and if ID3 (v1 or v2)
tags are present in the track some of the fields will be
automatically filled in for you. You should ensure that at
least the Title and Artist fields are completed – the other
fields will be useful for advanced track retrieval using the
searching functions.
The track will have been inserted into the playlist. You can
change it’s position or move it between lists as described
previously. To easily move tracks between playlists, select
New window from the Window menu. Then select Tile
from the Window menu. You can now easily move tracks
between playlists using drag & drop.
Alternatively you can use cut & paste or drag & drop from
the windows Explorer to add tracks. A folder hierarchy
can be added in a single operation using this method.

Properties window
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Synchronising the player
Whenever you add playlists and tracks, or change the
music database in any other way, the changes are stored
within emplode. The database on the player is not
updated until you synchronise. This allows you to work
quickly; adding tracks, organising your music and so forth;
without delays every time some data needs to be
transferred to the player.
When you are finished updating, you must synchronise
the player music database with the changes. From the File
menu select Synchronise or click the Synchronise control
in the toolbar. The synchronisation process can take
anything from several seconds to several hours,
depending upon how much new music you have added to
the database and whether you are using USB, Ethernet or
Serial. The Synchronise window will keep you up to date
with the progress of the operation.

Do not switch off or disconnect the player
during synchronisation.
Occasionally emplode will perform a more thorough
integrity check during synchronisation. This can take some
time on large capacity players.
When synchronisation is complete the player will be ready
for use with the updated music database.

emplode online help
The emplode toolbar features tool tips – if you’re not sure
of the function of a control, hold the mouse pointer over
it for a couple of seconds.
A full manual for emplode is available through the
Windows help system.
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six: operating the empeg car
player

The empeg car player is fast and intuitive to operate,
using either the front panel controls or the infra red
remote.

Front panel controls
The front panel has four function control buttons. Each
button provides different functions depending upon what
the player is currently doing, and whether you press and
release or press and hold.
Player mode

empeg

Tuner

Aux

Top (short)

Play/pause

Mute/unmute

Mute/unmute

Back

Top (hold)

Standby mode

Standby mode

Standby mode

Back (repeating)

Bottom (short)

Menu

Menu

Menu

Bottom (hold)

Menu

Select
Select (repeating)

Left (short)

Previous track

Previous preset

Previous item

Left (hold)

Rewind

Tune down

Previous (repeating)

Right (short)

Next track

Next Preset

Next item

Right (hold)

Fast forward

Tune up

Next (repeating)

When the player is in standby mode, pressing a button
will restore it to its previous mode of operation.

Rotary control
The rotary control allows you to control the sound
functions of the player.
When in play mode, the control allows you to adjust the
volume. Pushing the knob changes to another setting.
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Remote control
The infra red remote control provides fast access to many
of the player’s popular functions. As for the front panel
controls, the function of many of the buttons depends
upon the mode of the player at the time.

-

-

Menu Button
Reveals or hides the menu, or cancel.

–

+

AM
–

FM
+

REW

FF

=

PROG

Skip Left & Skip Right Buttons
In empeg mode these buttons skip to the previous or
next track respectively. In tuner mode they skip to the
previous or next preset, and in menu mode they move to
the previous or next item.
Rew & FF Buttons
In empeg mode these buttons skip backward or forward
within the current track. In tuner mode they adjust the
frequency.
Play/Pause Button
In empeg mode this button switches between play and
pause. In tuner and aux mode toggles the mute function.
Volume Up & Down Buttons
In empeg, tuner and aux modes these buttons adjust the
volume level.

DNPP

DIRECT
OK

TUNER

TAPE

CD

CD-MD
CH

DNPP Button
In empeg, tuner and aux modes this button changes to
the next visualisation. In menu mode it selects the
highlighted item.
Direct OK Button
In empeg mode this button accesses the advanced search
functions. In tuner mode it is used to enter a tuning
frequency.
Input Select Buttons
These buttons select tuner, aux and empeg modes
respectively.
CD-MD CH Button
This button switches between track information displays.
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Menu functions
All empeg car player functions can be accessed from the
menu system. Open the main menu by pressing the
bottom panel button or the
button on the remote
control. Change the currently highlighted menu function
with the left and right buttons on the front panel, or by
using the
buttons on the remote; when the required
function (or sub-menu) is highlighted, select it by pressing
the bottom button or the
button on the remote.
–

+

DNPP

Access playlists set up in emplode.
Move through playlists. Select
subplaylists. The arrow means ‘play all
playlists/tracks in this level’.

Controls what information is displayed.
A scrolling text line along the bottom of
the screen with track time on the right. If
visuals are switched on, they will be
displayed in the top section of the screen.
Displays title, artist, source/year. Track
number in playlist/total tracks in playlist
and track time.

Current track at top. Following four tracks
displayed below. Track number/total
tracks in playlist and track time.

No track information displayed.
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Controls visuals displayed.

There are a number of categories to
select from.
The name of the selected visual is
displayed for a few seconds.

You can move through visuals by pressing
on the remote control.
DNPP

Switches all visuals off.

Select source input.

Listen to empeg.

Listen to radio.

Listen to auxiliary input.

Switches shuffle on or off.

Puts unit into standby mode. Or press
and hold the top button.
Press any button to switch on.
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Displays information about the empeg
software.

Controls sound outputs and audio
feedback.
Controls the balance between left and
right outputs.

Control the equaliser.

Full instructions on using the equaliser
are on page 25.
Control the volume. Alternatively, use the
rotary control.
0.0dB is recommended for home use.
Control the volume with your amplifier.
Control audio feedback beeps.

Levels available are: off, low, medium and
high.
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Searching
While selecting music through the menu system is
convenient for selecting playlists, the empeg features
advanced searching algorithms.
Pressing
allows you to cycle through searching by PIN,
year (direct entry), track title, artist, genre, year or source.
DIRECT
OK

PIN/year
Enter a PIN or year using the numeric keypad on the
remote control.
Track title/artist/genre/source
When initially selected, the list shows every track on the
empeg. You can move through this list using the
buttons on the remote.
The empeg car uses a fuzzy logic matching algorithm to
find tracks. Use the remote to enter the first letter of the
item you are searching for. For example, if you are
searching for the artist ‘Chicane’ then press 2 on the
remote. The list will now show only artists that have A, B
or C as the first letter. Pressing 4 will reduce the
list to items that have G, H or I as the second
letter. Continue this until the list has just one
item, or move to your required selection using
the
buttons. Press
to select the item.
–

–

+

DNPP

+

If you wish to append the selection to the current
playlist, pressing
toggles between append and
select modes. Pressing
then adds the item to
the current playlist (for this time only – the actual
playlist remains unmodified).
CD-MD
CH

DNPP

Note that you only need to press the button once for a
letter. The search algorithm works by reducing the options
available until you either reach the item you are looking
for, or the list is short enough for you to move through
quickly.

empeg car user guide 25

Using the equaliser
The empeg car has an advanced parametric graphic
equaliser system.
When in the home, the equaliser allows you to edit
two channels. In the car you can edit four channels.
Move through the menu using the
buttons.
Change options using the
buttons.
–

AM
–

+

Two channel equaliser

FM
+

The two channel equaliser has the following options:
Locked
Unlocked

Changes left and right channels together.
Changes each channel independently.

Four channel equaliser

The four channel equaliser has the following options:
Locked All
Locked LR
Locked FB
Unlocked

Changes all 4 channels together.
Changes left and right channels together.
Changes front and back channels together.
Changes each channel independently

Pressing
will move out of the menu and allow
you to edit the equaliser bars.
then moves
through each bar.
+

+

Editing the frequency

Frequency range is 50Hz – 18,000Hz
Gain is -30dB – +12dB
Pressing
switches between adjusting the
frequency, gain, Q factor and combined gain and
Q factor.
DNPP

Presets

Editing the Q factor

You can save 16 presets. To edit a preset, select the
preset you wish to edit by using the
buttons
on the remote. To change the name of a preset,
press
when the preset is highlighted and enter
the name using the alphanumeric keypad on the
remote control.
AM
–

FM
+

DIRECT
OK

Saved
Save

Editing the gain

The current preset is saved.
Select to save the current settings.
You must name the preset before
you can save it.

Editing the combined
gain and Q factor

Entering a preset name
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1

2

3

4

5

6

7

8

9

0

Using the alphanumeric keypad on the
remote control
The remote control features an alpha numeric keypad
which allows you to enter numbers and letters.
According to the situation, the empeg will allow you to
enter numbers only, letters only, or numbers, uppercase
and lowercase letters.
When in the searching menus, the player takes a single
key press to mean any of the letters associated with that
number.
For example, if you press 5 the empeg will search for
tracks that have J, K or L as the first letter.
When entering a name for a preset, the empeg works
much like a mobile phone.
For example, if you press 2 the empeg will cycle through
2, A, B, C, a, b and c, along with accented characters.
Pressing
moves the cursor forward and back. If the
last letter you entered was lowercase, then the next letter
will be lowercase by default.
–

+
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seven: optional tuner module

The tuner module is an optional unit that stays in
the car with the docking sled. A full installation
guide is included with the module.
Radio display with RDS

You can access the tuner by pressing
on the remote
control, or selecting tuner in the source menu.
TUNER

Tuning
To enter a specific frequency using the numeric
keypad, press
on the remote control. Omit any
points – the tuner will work them out for itself. For
example, entering ‘1036’ will tune to 103.6.
Press
again to confirm and tune to that frequency.
Use the
buttons to fine tune in .10MHz steps.
DIRECT
OK

Frequency input box

DIRECT
OK

AM
–

FM
+

Presets
The tuner has three banks (A, B and C) of ten (0-9) presets.
Move through the presets by pressing a number button
on the remote or using the
buttons.
Move to a different bank of presets by pressing the
button.
–

+

TUNER

To store a preset, press
. Use
to select a bank
and then select a preset number. Then enter the
name. See section six for how to use the
alphanumeric keypad. To cancel saving a preset, press
on the remote control.
DNPP

Station or
preset name

TUNER

Preset name input box

Signal strength
Stereo

Preset bank
and number

Frequency

RDS available

RDS radiotext
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eight: upgrading the player
software

The software in the empeg car player can be upgraded via
your PC connection. Upgrades will be posted regularly to
the support section of our web site
(http://www.empeg.com/).
To install a car player upgrade, first download it from the
web site. Be sure to read the release notes! You will be
able to choose between the consumer and the developer
image – unless you are developing software for the player
you should choose the consumer image, as this has
performance benefits.
To upgrade the software the car player MUST be
connected by RS232 Serial – the USB and Ethernet
connections will be ignored. Ensure that the appropriate
COM port is specified in the emplode options (although
you can switch back to USB after doing so if you wish).
Disconnect the power cable from your car player and run
the empeg Upgrade Wizard from the Start Menu or from
the emplode Tools menu.
Click Browse and select the upgrade file that you have
downloaded, then click Next. Read the release notes and
click next again. When the software instructs you to do
so, connect the power cable to your car player
and the upgrade procedure will begin.
Upgrading takes a few minutes, during which
you will be informed of the progress. Your
music database, radio presets and other user
settings will not be affected.
Once the upgrade process is complete, the
player will reset and is ready for immediate use.

upgrade wizard
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nine: service and support

Cleaning
The player should be cleaned with a soft dry cloth. Do not
use abrasives or cleaning agents.
The player requires no physical maintenance. Removing
the cover voids the warranty.

Software maintenance
The hard disks do not require defragmenting or any other
software maintenance. The empeg uses a filing system
that keeps fragmentation to a minimum, and due to the
way the player caches well ahead when playing, delays
caused by any fragmentation are not a problem.

Contacting our service centre
Our service centre in Cambridge, England is available for
your after sales service and support requirements.
Email

support@empeg.com

Telephone
United Kingdom
United States
International

01223 576 123
1-877-259-5295 (Toll Free)
+44 1223 576 123

Telephone cover is provided Monday to
following times:
09:30 to 23:30
04:30 to 18:30
01:30 to 15:30

Friday at the
UK GMT
US EST
US PST

Messages can be left outside of these hours, or consider
using email.
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Mail

empeg Service
1 Signet Court
Swann's Road
Cambridge CB5 8LA
United Kingdom

Please contact us to obtain authorisation before
shipping any product for repair or upgrade.
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appendix a: technical specifications

Hardware
Processor

220MHz StrongARM S-1100-DA

Flash memory

1Mb

RAM

12Mb 60ns FPM

DSP

SAA7705H

DACs

16 bit sign-magnitude, fourfold oversampling digital
filters, noise shaping

Display

128 x 32 dot matrix vacuum fluorescent display, 2 bits
per pixel

IR

SIR IrDA I/O, Consumer IR input

Controls

4 pushbuttons, 1 rotary+push

HDD port

ATA 2.5" HDD standard 2MM header

HDD physical

ATA 2.5" HDD up to 19.5mm, corner mounting screws

Serial IO

9-pin PC serial port, data rate to 230Kbits/s, also
docked in-car

USB

12Mbit/s standard type B socket on head unit

Ethernet

10BaseT RJ45 socket on head unit

Power input

+12V on ISO connector fused at 3A with inline
fuseholder

Grounding

Negative earth only

Auxiliary ctrl output

+12V @ 1A maximum on ISO connector

Audio outputs

4V line level front & rear stereo phono (RCA) line jacks,
1V stereo phono (RCA) sockets on head unit

Audio inputs

1V line level stereo phono (RCA) line jacks

Other features

On board temperature sensor
Software controlled display brightness
Display night mode input
Audio mute input (for mobile phones)
Optional Tuner Module
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Tuner module (optional)
Type

FM fuzzy logic autotuning radio, RDS, RBDS capability

FM tuning range

88 to 108 MHz, 12.5 kHz steps

Audio
DAC sample rate

fixed 44.1KHz

DAC typical S/N ratio

110dBA

DAC typical output noise

3uV

DAC typical THD + N

1Khz, 0dB -70dBA

DAC typical dynamic range

1Khz (-60dB) 102dBA

DAC max crosstalk

10Khz -69dB

Aux input frequency response

20Hz to 18KHz

Aux input typical channel separation 50dB
Volume control range

-66dB to +20dB

Balance attenuation range LR

0dB to -30dB

Fader attenuation range FR

0dB to -30dB

Tone control range, bass/treble

-12dB to +15dB

Dynamic loudness level range

0dB to +14dB

Dynamic loudness offset range

0dB to +24dB

Dynamic bass boost level range

0dB to +14dB

Dynamic bass boost offset range

0dB to +24dB

Graphics equaliser

20 band parametric set as 2 x 10-band
or 4 x 5-band

Other audio features

Dynamic range compression

Electrical
Standby power

2.75 Watts

Standby power, drive spun up

3.30 Watts

Operating power, drive spun down

6.20 Watts

Operating power, peak

8.90 Watts

Input voltage

8 to 16 VDC

Switched auxiliary output

1A maximum load
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Environmental
Operating temperature range

5 deg. C to 55 deg. C

Standby temperature range

5 deg. C to 55 deg. C

Non-operating temperature range

-20 deg. C to 60 deg. C

Humidity, operating

10% to 90% RH, non-condensing

Humidity, non-operating

5% to 95% RH, non-condensing

Shock, operating

150G

Shock, non-operating

400G

Physical (maximum)
Docking unit

50mm (2") high
183mm (7.2") wide
173mm (6.8") deep

Head unit

55mm (2.2") high
186mm (7.3") wide
152mm (6") deep

Weight
2.5kg (5.5lbs) with two drives
Case material
1mm (0.04") stainless steel

Note
Figures vary depending on hard drive type fitted, power consumption figures
are shown with a single 18Gb drive. Drives are kept spun down as much as
possible during operation.
Specifications are subject to change without notice.
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appendix b: official certifications

FCC certification
This equipment has been tested and found to comply with the limits for a Class B
digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide
reasonable protection against harmful interference in a residential installation. This
equipment generates, uses and can radiate radio frequency energy and, if not installed
and used in accordance with the instructions, may cause harmful interference to radio
communications. However, there is no guarantee that interference will not occur in a
particular installation. If this equipment does cause harmful interference to radio or
television reception, which can be determined by turning the equipment off and on,
the user is encouraged to try to correct the interference by one or more of the
following measures:
• Re-orient or relocate the receiving antenna.
• Increase the separation between the equipment and the receiver.
• Connect the equipment into an outlet on a circuit different from that to which the
receiver is connected.
• Consult the dealer or an experienced radio/TV technician for help.
Shielded interface cables must be used to comply with emission limits.
You are cautioned that changes or modifications not expressly approved by the party
responsible for compliance could void your authority to operate the equipment.
This device complies with Part 15 of the FCC rules. Operation is subject to the following
two conditions: (1) This device shall not cause harmful interference, and (2) This device
must accept any interference received, including interference that may cause undesired
operation.

CE certification
This equipment has been tested and found to comply with European EMC Emissions
and Immunity regulations.
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appendix c: software license agreement

End user license agreement
For Emplode software
This Empeg Limited (“empeg”) End User License Agreement accompanies the product
and related explanatory materials (“Software”). The term “Software” also shall include
any upgrades, modified versions or updates of the Software licensed to you by empeg.
Please read this Agreement carefully. At the end, you will be asked to accept this
agreement and continue to install or, if you do not wish to accept this Agreement, to
decline this agreement, in which case you will not be able to use the Software.
Upon your acceptance of this Agreement, empeg grants to you a non-exclusive license
to use the Software, provided that you agree to the following.
Use of Software
You may install the Software on a hard disk or other storage device; install and use the
Software on a file server for use on a network for the purposes of (i) permanent
installation onto hard disks or other storage devices or (ii) use of the Software over a
network; and make backup copies of the Software.
You are not permitted to distribute copies of the Software to third parties.
Copyright and Trademark Rights
The Software is owned by empeg and its suppliers, and its structure, organisation and
code are the valuable trade secrets of empeg and its suppliers. The Software also is
protected by United Kingdom Copyright Law and International Treaty provisions. This
Agreement does not grant you any intellectual property rights in the Software.
Restrictions
You agree not to modify, adapt, translate, reverse engineer, decompile, disassemble or
otherwise attempt to discover the source code of the Software. The software is licensed
by empeg only for the purposes of interaction with empeg audio products.
No Warranty
The Software is being delivered to you AS IS and empeg makes no warranty as to its
use or performance. EMPEG AND ITS SUPPLIERS DO NOT AND CANNOT WARRANT THE
PERFORMANCE OR RESULTS YOU MAY OBTAIN BY USING THE SOFTWARE OR
DOCUMENTATION. EMPEG AND ITS SUPPLIERS MAKE NO WARRANTIES, EXPRESS OR
IMPLIED, AS TO NON-INFRINGEMENT OF THIRD PARTY RIGHTS, MERCHANTABILITY, OR
FITNESS FOR ANY PARTICULAR PURPOSE. IN NO EVENT WILL EMPEG OR ITS SUPPLIERS
BE LIABLE TO YOU FOR ANY CONSEQUENTIAL, INCIDENTAL OR SPECIAL DAMAGES,
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INCLUDING ANY LOST PROFITS OR LOST SAVINGS, EVEN IF ANY EMPEG REPRESENTATIVE
HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, OR FOR ANY CLAIM BY
ANY THIRD PARTY. Some states, countries or jurisdictions do not allow the exclusion or
limitation or incidental, consequential or special damages, or the exclusion of implied
warranties or limitations on how long an implied warranty may last, so the above
limitations may not apply to you.
Governing Law and General Provisions
This Agreement will be governed by the laws England and Wales, excluding the
application of its conflicts of law rules. This Agreement will not be governed by the
United Nations Convention on Contracts for the International Sale of Goods, the
application of which is expressly excluded. If any part of this Agreement is found void
and unenforcable, it will not affect the validity of the balance of the Agreement, which
shall remain valid and enforceable according to its terms. You agree that the Software
will not be shipped, transferred or exported into any country or used in any manner
prohibited by the United Kingdom Laws or any other export laws, restrictions or
regulations. This Agreement shall automatically terminate upon failure by you to
comply with its terms. This Agreement may only be modified in writing by an
authorised officer of empeg.
Unpublished-rights reserved under the copyright laws of the United Kingdom.
Empeg Limited, Dinder House, Dinder, Near Wells, Somerset, BA5 3PB. UK.
YOUR ACCEPTANCE OF THE FOREGOING AGREEMENT WAS OR WILL BE INDICATED
DURING INSTALLATION OF THE EMPLODE SOFTWARE.
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appendix d: GPL and LGPL

Parts of the software provided with the empeg car player are covered by the
GNU (http://www.gnu.org) General Public Licence and the Lesser General
Public Licence. Under the terms of the license we are required to provide the
source code for these components. These can be found on the CD in the
sources directory and on our website (http://www.empeg.com) in the support
section.
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appendix f: contact
information

email
General enquiries
Sales enquiries
After sales support
Bug reporting

info@empeg.com
sales@empeg.com
support@empeg.com
bugs@empeg.com

web
http://www.empeg.com

mail
empeg head office

1 Signet Court
Swann’s Road
Cambridge
CB5 8LA
United Kingdom

Telephone
United Kingdom
United States
International

01223 576 123
1-877-259-5295 (Toll Free)
+44 1223 576 123

Telephone cover is provided Monday to Friday at the
following times:
09:30 to 23:30 GMT
04:30 to 18:30 EST
01:30 to 15:30 PST
Messages can be left outside of these hours, or consider
using email.

Fax
United Kingdom
International

01223 576 124
+44 1223 576 124
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announcement mailing list
This is a low volume (usually around 1 message per
month) announcement list for those interested in empeg
products.
For subscription information, send an email to:
empeg-announce-request@empeg.com
with the word “help” in the subject.
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Notes
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Notes

www.empeg.com

uk head office
email
ICQ

info@empeg.com
45537290

telephone
+44 (0)1223 576123
us telephone
1-877-259-5295
fax
+44 (0)1223 576124
1 Signet Court
Swann’s Road
Cambridge CB5 8LA
United Kingdom

